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Extensive data on relationships of neural network oscillations to behavior and organization of neuronal discharge across brain regions call for
new tools to selectively manipulate brain rhythms. Here we describe an approach combining projection-specific optogenetics with extracellular
electrophysiology for high-fidelity control of hippocampal theta oscillations (5-10 Hz) in behaving mice. The specificity of the optogenetic
entrainment is achieved by targeting channelrhodopsin-2 (ChR2) to the GABAergic population of medial septal cells, crucially involved in the
generation of hippocampal theta oscillations, and a local synchronized activation of a subset of inhibitory septal afferents in the hippocampus.
The efficacy of the optogenetic rhythm control is verified by a simultaneous monitoring of the local field potential (LFP) across lamina of the CA1
area and/or of neuronal discharge. Using this readily implementable preparation we show efficacy of various optogenetic stimulation protocols
for induction of theta oscillations and for the manipulation of their frequency and regularity. Finally, a combination of the theta rhythm control with
projection-specific inhibition addresses the readout of particular aspects of the hippocampal synchronization by efferent regions.

Video Link

The video component of this article can be found at https://www.jove.com/video/57349/

Introduction

Neuronal activity in mammals is coordinated by network oscillations, which assist information transfer within and between brain regions1'2’3'4.

Brain rhythms include oscillations ranging from very slow (< 0.8 Hz) up to ultrafast (7> 200 Hz) frequencies. A large body of evidence supports
involvement of network oscillations in diverse brain functions, including cognitions’e' ’8’9'10, innate behaviors'""'? as well as neuropsychiatric
disorders such as Parkinson's disease and epilepsy13'14’15. Selective and temporally precise methods for experimental manipulation of network
oscillations are therefore essential for the development of physiologically plausible models of synchronization and for establishing causal links
with behavior.

Network synchronization is mediated by diverse biological substrates and processes, ranging from molecular identity of ion channels and
their kinetics to neuromodulation of excitability and network connectivity. The biological design of rhythm generators16 has been revealed

for many brain rhythms, distinct aspects of which (e.g., frequency, amplitude) are often brought about by dynamics of distinct cell types and
networks. For instance, inhibitory interneurons tar%eting the somata of principal cells are the most important players across frequency bands
and brain regions17‘18, including theta'®?, gamma 21 "and ripple (140-200 Hz)22 oscillations. In turn, phase synchronization of distant cells

is ensured by robust feed-forward signaling of pyramidal cells, which resets the firing of interneurons. A crucial parameter of oscillations, the
size of the synchronized neuronal population, is closely related to the measured LFP oscillation's amplitude and, at least for fast oscillations,
depends on the excitatory drive onto interneurons?. In contrast, slower oscillations, like delta and theta rhythms, are generated by long-range
reentrant loops, formed by cortico-thalamic®?* and hippocampal-medial septal projection525‘26’27, respectively. Oscillations in such circuits are
brought about by interactions of signal propagation delays, excitable responses, and their frequency preference in participating cellg?8:29.30.31:32
Inhibitory projections from GABAergic parvalbumin (PV)-positive cells of the medial septum (MS) to interneurons in the hippocampu325'33,
parahippocampal regions and entorhinal cortex?® are essential for the generation of theta oscillations in the medial temporal lobe. Thus,
physiological mechanisms of network oscillations and neuronal synchronization can be manipulated using optogenetics with a real-time
precision.

Cell tyge-speciﬁc optogenetic manipulations have been applied for studizes of the hippocampal and cortical oscillations in vitro3*35:36:37.38

in viv3039404142434445 i oy ding functional investigations of gamma® 12%6:464748498051.52 5y rinple oscillations**®*** and sleep spindles
Recently we expressed a Cre-dependent ChR2 virus in the MS, a key region for the generation of the hippocampal theta rhythm, of PV-Cre

mice. Using this preparation, features of the hippocampal theta oscillations (frequency and temporal stability) were controlled by optogenetic
stimulation of inhibitory projections of the MS in the hippocampus". Furthermore, theta-frequency optogenetic stimulation of inhibitory septo-

55,56
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hippocampal projections evoked theta rhythm during awake immobility. The optogenetically entrained theta rhythm displayed properties of
spontaneous theta oscillations in the mouse at LFP and neuronal activity levels.

Key features of this protocol include: (1) utilization of an inhibitory pathway that is physiologically critical for spontaneous theta oscillations while
avoiding unspecific effects on hippocampal excitability; (2) axonal, i.e., projection-specific stimulation to minimize a direct influence on non-
hippocampal MS efferents; (3) local theta-rhythmic light stimulation, ensuring a minimal direct interference with theta-rhythmic septo-hippocampal
dynamics and a global bilateral entrainment of theta oscillations; (4) parametric control of theta oscillations frequency and regularity; and (5)
quantification of entrainment fidelity with high temporal resolution using LFP to enable quantitative causality analysis in behaving animals. Since
this preparation essentially capitalizes on a well-known role of the septo-hippocampal disinhibition in theta generation25'3°, it enables robust
control over several parameters of theta oscillations in behaving mice. Studies where other less investigated pathways and cell types of the
septo-hippocampal circuitry were manipuIated38'3’9'47"‘9'50'51'52'5 54:56,56,57.58 reveal further mechanisms of the theta rhythm.

-—

PV-Cre knock-in male mice®, 10-25 weeks old, were used. Mice were housed under standard conditions in the animal facility and kept on a 12 h
light/dark cycle. All procedures were performed in accordance with national and international guidelines, and were approved by the local health
authorities (Landesamt fur Natur, Umwelt und Verbraucherschutz, Nordrhein-Westfalen).

. Viral Injection

1. During the whole procedure, follow biological safety guidelinesso. Wear a lab coat, a surgical mask, a hairnet, and two pairs of gloves.

2. Cut tubing with a sterile scalpel or scissors to approximately 1 m length, insert it in the syringe holder block of the pump, and fix it.

Fill the tubing entirely with silicon oil by using the syringe.

Check whether air bubbles appear in the tubing. If air bubbles are observed, refill the tubing again with oil.

Fix the plunger to the pusher block.

Slowly advance the pusher towards the syringe holder block until the tip of the plunger touches the tubing.

Insert the tip of the plunger into the tubing and automatically move the pusher block forward at a slow speed by selecting "Infuse" in the
command window and a low infusion rate (e.g., 500 nL/min) until it reaches the syringe holder block.

aRwN -~

3. Prepare the injection needle (34G).
1. Remove the needle hub with a clear cut using a precision drill/grinder connected to a cutting disk. If necessary, use a needle to remove
metal residues from the freshly cut surface.
2. Thread capillary tubing (3-4 cm length) through the needle.
3. Glue the needle to the tubing with super glue.
4. Connect the injection needle to the end of the tubing, which connects to the microsyringe pump.

Attach the needle to the stereotaxic holder.

Withdraw air until an air bubble in the transparent tube above the needle is visible.

Anesthetize the mouse with 1.5-3% isoflurane in oxygen. Wait approximately 2-3 min, then confirm that the mouse is fully anesthetized by

assessing its response to a toe pinch. Throughout the surgery monitor the animal's breathing and adjust isoflurane concentration if required.

Place the mouse in the stereotactic frame using non-traumatic ear holders.

Protect the eyes of the mouse with a lipid gel.

Inject 0.1 mL lidocaine intradermally under the head skin using a 0.01-1 mL syringe and a 26G injection cannula.

0. Shave and disinfect the mouse's head using ethanol solution. Then alternate three times 2 % chlorhexidine with ethanol to disinfect the

surgical site.

11. Perform a midline incision using fine and sharp scissors going from between the back of the ears to the level of the eyes so that the bregma
and lambda are visible.

12. Clean the skull by applying approximately 50 pL of NaCl using a syringe and dry with a paper tissue and an air puff.

13. Position the mouse head by adjusting the dorso-ventral level of the nose clamp so that the bregma and lambda are on the same dorso-
ventral level (x 0.3 mm).

14. Drill a hole above the MS (AP 0.98 and L 0.5 mm in reference to the bregma).

15. At this point, defrost an aliquot of the virus (should contain at least 2 yL of AAV2/1.CAGGS.flex.ChR2.tdTomato. WPRESV40) for
approximately 5 min at room temperature (RT).

16. Centrifuge the aliquot at approximately 4,000 x g at RT for 1 min.

17. Pipette the 2 pL of the virus onto a piece of Parafilm; use the previously protected side.

18. Submerge the tip of the injection needle in the liquid and carefully withdraw at about 500 nL/min while observing the level of the liquid. To
prevent air suctioning, stop withdrawal before the virus is entirely taken up. Adjust the withdraw rate according to the solution viscosity; a
faster rate can facilitate withdrawal of a virus with higher viscosity.

19. Clean the needle with a paper tissue.

20. Check that the virus is contained in the tube and the virus and oil are separated by an air bubble. Mark the level of the virus on the tube in
order to control whether virus is successfully infused during the injection.

21. Position the needle above the craniotomy and slowly insert it into the brain at the first injection point (AP 0.98, L 0.5, V -5.2, 5.5° lateral).

22. Inject 450 nL of the virus at a rate of 100-150 nL/min. Wait for 10 min. Carefully move the needle up 0.1 mm and wait another 5 min.

1. Move the needle to the second injection point (AP 0.98, L 0.5, V -4.6) and inject another 450 nL at 100-150 nL/min.

2. Wait again for 10 min before moving the needle up 0.1 mm. Wait another 5 min before removing the needle.

ook~
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23. Suture the incision with Silk Black Braided suture using square knots. Warm the animal with a red lamp to speed up the recovery. Administer
antibiotics (0.3 mL Erycinum (1:4 in sterile NaCl)) and carprofen i.p. daily 2-3 days after surgery.
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24. Cut the tube above the mark that indicated the level of the virus. The tube can be used for further injections. Prepare a fresh injection needle

before each injection.

NOTE: This surgery takes about 1-1.5 h. The animal wakes up typically within 5 min after surgery. Wait a minimum time of 6 weeks for
sufficient axonal expression but not longer than 5 months before performing stereotactic implantations, as expression levels begin to
decrease approximately 6 months after the virus injection.

2. Preparation of Optic Fibers (Figure 1A)

o

Noos

Use multimode optic fiber (105 uym core, glass clad with silica core, 0.22 NA). Strip 125 ym cladding of the fiber core using a micro-stripper
while the fiber is still attached to the fiber spool.
Cut the fiber to a length of approximately 2-3 cm using a diamond knife.
Insert the fiber in a zirconia ceramic stick ferrule (ID: 126 ym). Approximately 0.5-1 mm of the optic fiber should protrude from the convex side
of the ferrule.
Using a needle, apply one drop of epoxy glue to both ends of the ferrule but not onto the sides of the ferrule. Alternatively, use super glue.
Allow the glue to dry for at least 30 min.
Polish the convex side of the ferrule using diamond lapping fiber polishing film (3 pm grits).
Test the fidelity of light transfer using an optical power meter.
1. Set the wavelength on the power meter to the same wavelength as the laser being used.
2. Position the patch cord with the tip facing the center of the sensor. Power on the laser and read the light output from the power meter.
Record the value.
3. Connect the optic fiber to the patch cord via a mating sleeve and position it with the tip of the fiber facing the center of the sensor.
Power on the laser and read the light output from the power meter. Record the value.
4. Calculate the transmission rate: divide the second value by the first value. If the transmission rate is below 0.5, discard the fiber,
otherwise use it for implantation.
5. Test the transmission rate for each fiber before implantation.
6. For later experiments, adjust the light intensity output of the laser to the transmission rate of the optic fiber: set the light output from the
patch cord tip to 5-15 divided by the transmission rate to achieve a final light output from the fiber tip of 5-15 mW.
NOTE: See also ref. ' for the preparation of optic fibers.

3. Preparation of Tungsten Wire Arrays for LFP Recordings (Figure 1B)

Glue several (for example 6) 100 pum silica tube guides in parallel to the sticky side of a piece of tape. Cut one piece, approximately 4-6 mm,
for one wire array assembly.

Thread formvar-insulated 45 ym tungsten wires through the guide tubes using forceps.

Strip six enamel-insulated fine copper bonding wires (approximately 5 mm long) and a grounding wire (approximately 2-3 cm long) by using a
scalpel to scrape away the insulation on both ends. Solder them to the nanoconnector pins.

Connect each bonding wire to one tungsten wire using one drop of silver conductive paint, respectively. Let dry for at least 30 min.

Apply a minimum amount of cement to cover the wires. Do not apply cement on the tungsten wires, which will be inserted in the brain tissue
or on the upper part of the nanoconnector. Let the cement dry for at least 30 min.

Perform an angular cut (5-20°) of the tungsten wires using blunt stainless-steel scissors to enable reliable implantation of wires below or
above the zone ventrally adjacent to the stratum pyramidale, where theta amplitude is too low for the estimation of the entrainment fidelity.
Deinsulate the tip (approximately 2 mm) of the ground wire by using a scalpel to scrape away the insulation. Treat it with flux and presolder.
Check potential cross-talks between electrodes using a digital multimeter. To do so, connect the connector pins to the multimeter, which must
be set to the resistance measurement mode. Check pairwise combinations of channels; a reading on the multimeter below 5 MQ indicates
significant cross-talk.

Check the impedance of each wire electrode in saline using an impedance meter. Typical impedance values are below 100 kQ.

. To facilitate implantation, glue one optic fiber to the wire array so that the tip of the fiber is at the level of the shortest wire and the fiber tip is in

close proximity, but not touching the tungsten wires. Keep the angle of the fiber as small as possible in order to prevent tissue damage during
implantation.
NOTE: See also ref. ® for fabrication of tungsten wire arrays.

4. Stereotaxic Implantations

N =

Perform preparations as described in steps 1.6-1.13.

Remove the connective tissue from the top of the skull and push down neck muscles thoroughly by approximately 2 mm to prevent muscle
artifacts during the recording.

Clean the skull using a cotton-tip applicator and saline, and drill 4 holes (2 in the front and 2 above the cerebellum, 0.8 mm diameter) to place
bone stainless-steel screws (00-96x1/16) for ground and stabilization of the implant (Figure 1D). Position the ground screw, connected to one
copper wire (approximately 2-3 cm length) above the cerebellum.

Cover the ground-screw completely with cement to prevent muscle artifacts during the electrophysiological recordings. Build a cement ring
connecting all screws (Figure 1E).

Perform a craniotomy above the implantation side (Hippocampus, AP -1.94, L 1.4, V 1.4 in reference to the bregma). Apply approximately 5
UL of sterile NaCl on the surface of the brain tissue.

Slowly lower the wire array using stereotaxis in the craniotomy. For unitary recordings, implant a silicone probe instead of a wire arrayes;

in order to prevent optoelectric light artifacts, implant the optic fiber separately in the hippocampus with the fiber tip not directly facing the
probe (Figure 1C - 1). For investigation of the coordination of the entrainment between hemispheres, implant an additional optic fiber in the
contralateral hippocampal CA1 area.
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7. Apply approximately 5 uL of warm liquid wax/paraffin oil, preheated at 70 °C, with a syringe above the implantation site to protect brain tissue.

Apply cement around the wire array and cover the skull with cement.

9. Apply one drop of flux to the presoldered ground/reference wire and the presoldered wire connected to the ground screw using for instance a
needle, and fuse the wires using a soldering machine.

10. Cover the entire ground wire with cement.

11. Administer 0.3 mL Erycinum (1:4 in sterile NaCl) and carprofen (5mg/mL) i.p. after surgery and for at least the two days following. The mouse
typically wakes up within 15 min following surgery. Warm the animal with a red lamp to speed up recovery.

12. Monitor the weight of the mouse daily for the first week following the surgery or until the weight is stable. Weight loss should not exceed 10%
of the mouse weight recorded before surgery. To accelerate stabilization of weight, supply the mouse with wet food and condensed milk
during the first days following the surgery.

13. To record hippocampal cellular activity during entrainment, implant a silicone probe in the hippocampus (AP -1.94, L 1.4, V 1, with
subsequent lowering) as described in ref. 62 (Figure 1C - 1). Implant the optic fiber in the hippocampus at AP -3, L 1.4, V 1.6, 39° caudal-
rostral. Implant an additional optic fiber in the MS (AP +0.98, L 1, V 3.9, 15° lateral) if stimulation of cell somata is desired.

®

5. Optogenetic Stimulation and Electrophysiological Data Acquisition

1. Habituate the mouse to the recording setup (e.g., 15 min sessions, 1-2 sessions per day for 3 days). Examine the animal's behavior before
starting with the first experiments. If the mouse is moving in the chamber, exploring the environment, sniffing, performing rearings, efc., start
the first experimental session.

2. Place the mouse in a familiar chamber in the absence of other animals in the same room.

3. Attach an LED to the head-stage using adhesive tape to track the animal's position. Make sure that the LED light is captured by the camera
throughout the period that the animal is exploring the recording chamber before starting the experiments. Record in the dark in order to track
the LED light. Position a camera above the recording chamber.

4. Check the light output from the patch cord. Estimate the light output from the fiber tip after connection depending on transmission rate of the
fiber implanted. Ensure that the light output from the tip of the fiber is between 5-15 mW, to enable reliable entrainment.

5. Connect the headstage preamplifier to the chronically implanted connector. Connect the fiberoptic patch cord to the chronically implanted
hippocampal fiber for optogenetic stimulation experiments. In control light stimulation experiments, connect the optic fiber to a dummy ferrule
connected to the headset.

6. Place the mouse in the recording chamber.

Open the software to control the stimulus generator to generate the stimulation protocol.

8. Select the channel that controls the 473 nm DPSS laser. In the first row enter 3,000 mV (1st column), time 30 ms (2nd column), value 0 mV
(3rd column), time 112 ms (4th column), row repeat 840, and group repeat 1, to generate a protocol for 2 min of 7 Hz stimulation with 30 ms
long pulses. Adjust the time duration in the 4th column and number of row repetitions if the stimulation at another frequency or a different
duration is required. In the second row select 0 mW (1st column), time 500 h (2nd column), row repeat 1, and group repeat 1, to ensure that
the laser is being switched off after the stimulation protocol is terminated.

9. Click "File > Save as" and save the file with a desired name.

10. Assure that the stimulator TTL output triggering the laser is connected to the Digital Lynx analog input board to synchronize the acquisition of
electrophysiological and optogenetic data.

11. Alternatively, to parametrically regulate the variability of theta oscillation frequency, apply trains of light pulses at varying inter-pulse intervals,
with periods following a Gaussian distribution. Modify the dispersion of inter-pulse intervals for different protocols, e.g., from step 3.2 to 15.1
ms?. Apply these protocols to generate theta epochs with different variability of the theta frequency (Figure 6).

12. Open the software of the recording system. Click on "ACQ" to acquire and "REC" to record. Wait before initiation of the light stimulation to
record the baseline behavior (e.g., 2 min to retrieve baseline speed or 30 min to extract the baseline place fields).

13. Open the software to control the stimulus generator. Click "File > Open" and select the protocol file of choice. Click "Download and Start" to
initiate the light stimulation.

NOTE: The experiment can be surveyed, and the stimulation started via remote control; this excludes the influence of the presence of
the experimenter on the animal's behavior. Depending on the goal of the study, stimulation can be initiated and terminated during specific
behaviors.

N

6. A Combined Approach for Optogenetic Entrainment and Projection-specific Inhibition of
the Hippocampal Output

1. Express ChR2 in MS GABAergic cells of PV-Cre mice, as described in section 1.
In addition, inject a total of 2.4 pL of CamKlla dependent halorhodopsin (eNpHR3.0, AAV2/1.CamKlla.eNpHR3.0-EYFP.WPRE.hGH) in both
dorsal hippocampal hemispheres (AP -1.7; L + 1.05; V -2.05 and -1.4 mm; AP -1.7; L £ 1.7; V -2.05 and -1.55 mm; AP -2.3; L £ 1.5; V -2.2
and -1.3 mm; AP -2.3; L + 2.2; V -1.65 and -2.45 mm).

3. Allow 6 weeks of expression time.

4. Implant a tungsten wire array with optic fiber in the hippocampal CA1 region, as described in section 4. Additionally, implant bilaterally optic
fibers in the lateral septum (LS, AP 0.1, L 0.25, V -2.25 mm, and AP 0.5, L -0.3, V -2.7 mm).

5. Perform optogenetic theta entrainment experiments as described in steps 5.4-5.5.

1. For simultaneous inhibition of the hippocampal output to the LS, generate a protocol stimulus generation: e.g., trigger the onset of the
output channel connected to the 593 nm DPSS laser 15 s with a continuous pulse lasting in total 45 s, before triggering the pulses
output to the 473 nm DPSS laser.

2. Connect both fibers in the LS via patch cords using a multimode fiber optic coupler to a 593 nm DPSS laser.

3. Start the recording and download and trigger the protocol to control the stimulus generation.
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7. Data Processing

1. Convert theglectrophysiological signals and position the tracking data with Neurophysiological Data (ND) Manager to .dat and .pos formats,
respectively™ .

2. Obtain the LFP by low-pass filtering and down-sampling of the wide-band signal to 1,250 Hz using ND Manager66.

3. In each recording, select the channel with the maximal amplitude of theta oscillations (using Neuroscope)19.

4. Detect the timestamps of the laser pulses and of the stimulation epochs with a threshold detecting algorithm (using MATLAB function
findpeaks.m or similar)”.

5. To import the .dat file in a multi-channel data analysis software, click "File > Import", select "binary files" as the data type, and select the .dat
file. In the configuration dialog, enter the correct number of channels and a sampling rate of 1,250 Hz, click "ok", and save as .smr file.

Plot power spectra by selecting "Analysis > New Result View > PowerSpectrum”. In the settings, select the channel with the highest theta
amplitude and 16,384 FFT size, click "New", define as "Start time" the beginning of the stimulation epoch and as "End time" the end of the
stimulation epoch, and click "Process".

6. Calculate the entrainment fidelity as the ratio of the cumulative power spectral density (PSD) within the optogenetic stimulation frequency
range (stimulation frequency + 0.5 Hz), to the cumulative PSD in the theta (5-12 Hz) band with the multitaper method (NW = 3, window size
8,192) for 10 s epochs (e.g., toolkit <http://chronux.org/>).

7. Exclude recording epochs where the dominant PSD peak is < 5 Hz from analysis (non- theta epochs, using MATLAB function find.m).

8. Plot the raster of the LFP power spectra for all recorded epochs according to the computed entrainment fidelity (using MATLAB functions
sortrows.m and pcolor.m). Load the power spectra and entrainment fidelity by clicking "File > Open", stored variable In. Type Power =
sortrows(In,1); pcolor(Power(:,2:end)).

Representative Results

Targeting of ChR2 to GABAergic cells in the MS as described in section 1 is illustrated in Figure 2A. Optogenetic stimulation of axons of MS
GABAergic cells in the dorsal hippocampus via an optic fiber which is implanted above the CA1 area entrains theta oscillations at the frequency
of the stimulus in the ipsilateral (Figure 2B) as well as contralateral hemisphere (Figure 2C). Theta oscillations could be more or less efficiently
entrained by the optogenetic stimulation (Figure 3A), the efficacy of which was computed for each recording epoch as a relative theta LFP power
around the stimulation frequency, i.e., entrainment fidelity (Figure 3B). Entrainment fidelity above 0.3, i.e., higher than in the spontaneous light-
off recordings, was observed in approximately 80% of the recording epochs. Optostimulation at non-theta frequencies was less effective (Figure
3C).

Explicit i.e., parametric manipulation of theta oscillations frequency is accompanied by emergent changes of theta regularity: the temporal
regularity of amplitude and frequency of the theta oscillations was increased during epochs with high entrainment fidelity. The stability of
oscillations can also be regulated parametrically by applying trains of light pulses, periods of which follow Gaussian distributions with different
dispersions (Figure 4).

Optogenetic control over the oscillations frequency eliminated the correlation between theta frequency and running speed, in agreement with
the frequency control via the MS by ascending afferents during movement (Figure 5A). Optostimulation also induced theta oscillations during
immobility (Figure 5B). The preferential firing phases recorded in the CA1 area in putative pyramidal cells and interneurons were unchanged
relative to the optogenetically entrained theta oscillation when compared to spontaneous theta (Figure 6).

To study the contribution of the hippocampus to the lateral septum pathway in theta-mediated regulation of locomotion, we optogenetically
inhibited this pathway. Halorhodopsin (eNpHR3.0) was bilaterally expressed in hippocampal pyramidal cells (Figure 7A), whereas ChR2 was
expressed in MS GABAergic cells as above and theta oscillations were optogenetically entrained (Figure 7B). The theta entrainment reduced
variability of running speed but not when the hippocampus to the LS pathway was inhibited (Figure 7C).
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Figure 1: lllustration of optic fibers, electrodes and surgery. (A) lllustration of an optic fiber. (B) lllustration of a wire array glued to an

optic fiber for the recording of hippocampal LFP during entrainment of hippocampal theta oscillations. (C) For recording of the hippocampal
cellular activity, a silicone probe is mounted on a microdrive. (D) Miniature screws are positioned on the skull. Copper wires are presoldered to
the ground and reference screw before positioning them above the cerebellum. (E) Cement is applied to cover and connect the screws. The
upper blue circle indicates where the craniotomy was performed for the implantation of the silicone probe. Lower blue circle indicates where the
craniotomy was performed for the implantation of the optic fiber in the hippocampus. (F) One optic fiber is implanted in a caudal-rostral angle to
target the hippocampal CA1 region. A second fiber can be implanted in the medial septum if stimulation of cell somata is desired (optional). (G)
The silicone probe is lowered to just above the hippocampal CA1 area. (H) The borders of the microdrive and connector are cemented to the
implant and ground, and the reference wires are soldered. (I) Copper mesh is constructed to surround the implant and serve as a Faraday cage.

Please click here to view a larger version of this figure.
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Figure 2: Preparation for optogenetic hippocampal theta entrainment. (A) ChR2 was expressed in PV* medial septal cells in PV-Cre
mice (upper scheme). Bright fluorescence in MS (1, 2) confirms successful construct expression in somata. MS fibers project via fornix (f) and
fimbria (fi) to the hippocampus (3-6); aca: anterior commissure; anterior part. HDB: nucleus of the horizontal limb of the diagonal band; Or:
stratum oriens. The optic fiber for optogenetic stimulation with blue light is implanted above the pyramidal layer of hippocampal area CA1 (lower
scheme). Scale bars: 500 pm (images 1, 3, 4) and 50 um (images 2, 5, 6). (B) Hippocampal LFP during spontaneous theta oscillations (left) and
7 Hz (middle) or 10 Hz (right) optogenetic entrainment. Blue stripes indicate the time windows of light application. Note the phase reset by the
light pulse indicated by an arrow. Note gamma envelopes during spontaneous and entrained theta, an indicator of physiological theta rhythm.
Phase reversal between stratum oriens (str. or.) and stratum radiatum (str. rad.) is also maintained during entrainment. (C) Entrainment is reliable
during ipsilateral (upper plots), as well as contralateral (lower plots) optogenetic stimulation. Schemes illustrate positions of fibers in respect to
electrodes positions. Example LFP traces during theta and application of light pulses are shown in the middle. On the right, power spectra of

hippocampal LFP during ipsi- and contralateral stimulation color-coded according to stimulation frequency. This figure has been modified from
ref. ''. Please click here to view a larger version of this figure.

Contralateral

Power (au)

Copyright © 2018 Journal of Visualized Experiments June 2018 | 136 | e57349 | Page 7 of 13


https://www.jove.com
https://www.jove.com
https://www.jove.com
/files/ftp_upload/57349/57349fig2large.jpg

lee Journal of Visualized Experiments www.jove.com

A B Spont, theta  Opt. entrained theta
7 Hz 10 Hz

Low entrainment fidelity

JA L L e
im. freq.
0
W"J\WW“W'HM\WM% U243112 024681012 24681012 )1 ? ?1|0 i

Power

395 1
08 8
06 &
0432
2
0

LFP frequency (Hz) Entrainment fidelity

g
=

S
High entrainment fidelity

‘.%MWJ‘LMWWWWﬂ 2mv
1s

Rec. epochs

24681012 24681012 24661012 o¥oPele® 1

8 Hz 9Hz

: 5
Power®

:?_ 3
=

Rec. epochs

24681012 4681012 24681012
LFP frequency (Hz)

Figure 3: Fidelity of optogenetic hippocampal theta entrainment. (A) Example hippocampal LFP traces during low and high entrainment
fidelity. (B) Power spectral densities of 10 s epochs during spontaneous theta, with rows ordered according to leading theta frequency (left), and
during 7 Hz (middle) and 10 Hz (right) optogenetic stimulation, with rows ordered according to entrainment fidelity. Respective example power
spectra (indicated by an arrow) are plotted above. Note reliable entrainment fidelity across epochs. On the right, the cumulative probability of
entrainment fidelity for theta frequencies is shown. (C) Entrainment requires theta rhythmic stimulation. Hippocampal network activity can be
successfully entrained using frequencies between 6-12 Hz. At lower frequencies (e.g., 2 or 4 Hz) or higher frequencies (e.g., 20 Hz) entrainment
is not reliable. This figure has been modified from ref. " Please click here to view a larger version of this figure.
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Figure 4: Parametric manipulation of theta oscillations regularity. (A) Stimulation was applied at varying frequencies within the theta range
with a mean frequency of 7.8 Hz following a Gaussian distribution. The standard deviation of the inter-pulse intervals was increased across
protocols from o = 3.19 to o = 15.09. In total, 11 protocols were generated and applied, each with a total duration of the stimulation epoch of 1
min. Of those, the probability distribution of 5 protocols are shown on the left of the figure. The power spectral densities within a range of 1-14
Hz of the hippocampal LFP during application of the respective protocols are plotted in the middle of the figure. The probabilities of the theta
periods during application of the respective protocols are illustrated on the right. (B) The variance of the applied inter-pulse intervals determined
the variance of the concurrent theta period (Pearson's r = 0.94, p = 0.0002). (C) The relationship between the theta amplitude variability and the
inter-pulse interval (Pearson's r = 0.61, p = 0.08). This figure has been modified from ref. ™. Please click here to view a larger version of this
figure.
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Figure 5: Optogenetic theta rhythmic entrainment determines hippocampal LFP during behavior. (A) Optogenetic stimulation frequency
determined the theta frequency during locomotion. Hence, speed-related afferents do not impact hippocampal theta frequency, and as a
consequence, speed is not correlated with theta frequency (blue) as it is during spontaneous theta (black). Data are presented as mean + s.e.m.
(B) During quiet wakefulness, the hippocampal theta can be elicited in the absence of movement. Hippocampal LFP traces before and during
successful entrainment are shown above, and example speed traces recorded during entrainment are shown below (the red trace corresponds
to the hippocampal LFP trace depicted above). Blue stripes mark the time windows of light stimulation pulses. This figure has been modified from
ref. ''. Please click here to view a larger version of this figure.
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Figure 6: Hippocampal cellular activity during theta entrainment. (A) Cellular activity was recorded using silicone probes (scheme). Single
interneurons and pyramidal cells were isolated and identified according to their respective waveform. Shown here is the average waveform
(middle) and auto-correlogram of an example isolated pyramidal cell. (B) Preferred discharge phase of pyramidal cells (Pyr) was not different
during spontaneous (in black, n = 29 neurons) and optogenetically entrained (in blue, n = 30) theta (p = 0.79). (C) Shown here is the auto-
correlogram (left) and preferential firing phase of a fast-firing interneuron during spontaneous and optogenetically entrained theta. Below the
corresponding hippocampal LFP rhythm during spontaneous (left) and entrained (right) theta. (D) Preferred discharge phase of fast-firing
interneurons was not different during spontaneous (in black) and optogenetically entrained (in blue, n = 28 neurons) theta (p = 0.97). Average
auto-correlogram is shown on the left. (E) Average auto-correlogram str. oriens cells. (F) Preferred discharge phase of str. oriens interneurons
was not different during spontaneous (black) and optogenetically entrained (blue, n = 10 neurons) theta (p = 0.56). Histograms of preferred
discharge phases are shown on the right. (G) Average firing rates were not affected by theta entrainment in pyramidal cells (p = 0.98), fast-firing
interneurons (p = 0.96) or str. oriens interneurons (p = 0.85). This figure has been modified from ref. " Please click here to view a larger version
of this figure.
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Figure 7: Combination of hippocampal theta entrainment and optogenetic inhibition of the hippocampal subcortical output through
the LS. (A) eNpHR3.0 (halorhodopsin) was expressed in hippocampal pyramidal cells (upper scheme). Successful expression of the construct
was confirmed by bright fluorescence in somata in the hippocampus (upper images) and axons in the LS (lower images). Optic fibers were
implanted bilaterally above the LS (lower scheme). Scale bars: 500 pm (images on the left), 50 um (images on the right). (B) Hippocampal
theta is successfully entrained during inhibition of the hippocampus to LS pathway. Here shown are power spectral densities for 9 Hz blue light
stimulation during output inhibition. (C) Inhibition of the major hippocampal subcortical output pathway prevents effects of hippocampal theta
entrainment on speed. Here shown is decrease in speed variability upon optogenetic entrainment (white bar with blue borders), with is absent
upon simultaneous inhibition of the hippocampus to LS pathway (yellow bar with blue borders). Respective average baseline speed is shown on
the left. This figure has been modified from ref. " Please click here to view a larger version of this figure.

Here we presented a widely accessible methodology to entrain and elicit hippocampal theta oscillations in the behaving animal. This approach
can be useful for studies of theta rhythm's functions in information processing and behavior. Critical aspects of this method include: (1) choice

of the opsin and targeting of ChR2 to axons of MS cells in the hippocampus, (2) robust optical and electrical features of implanted optic fiber-
wire array assemblies to ensure continuous stimulation and LFP recording in behaving mice, (3) application of an optimal amount of light at theta
frequencies, (4) post hoc quantification of the entrainment fidelity, and (5) control of optoelectrical artifacts.

PV-Cre; ChR2: MS-Hip

The main caveat of the first point is a secure virus injection sparing the medially located venous plexus. Suboptimal surgical execution of this
step can decrease the success rate of injections and potentially delay the acquisition of results. Kinetics of an opsin should be considered, ChR2
(activation time: 2 ms, inactivation time: 9 mse5). The second point demands control of the light transmission fidelity and impedance of recording
electrodes before implantation, and usually benefits from timely fabrication of additional implants.

The third consideration is common for optogenetics aiming at large scale circuit manipulations, and involves light sources and optical
interconnections, which deliver via a 100 um fiber light power in the brain of 5-15 mW. For each mouse and before each recording, a test
recording can be performed to set the light output to the optimal intensity for the experiment. The light output should be high enough to activate
a sufficient number of projections to allow reliable entrainment of theta oscillations, but not too high, in order to prevent thermally-evoked
responses and tissue damage.

The forth aspect regards the synchronization of light pulses and LFP data, achieved with the highest precision by sampling both data types
via the same AD converter. Synchronized time stamps are particularly required for other potential applications aiming at studies of neuronal
discharge and LFP. Entrainment efficacy can vary between and within stimulation epochs; this most likely occurs because of rhythmicitby
interference set by optogenetic stimulation with intrinsic- and/or sensory driven signals, due to multiple generators of the theta rhythm1 v66,67,68
Quantification of the instantaneous fidelity of this highly dynamic optogenetic manipulation69 is therefore extremely helpful for causal inference,
i.e., for revealing relationship between an effect magnitude (e.g., change in behavior) and the momentary efficacy of the optogenetic control of
selected synchronization aspects. Importantly, the multiple oscillation parameters may be influenced by optogenetic stimulation, e.g., entrainment
mediates not only frequency locking but also a more regular amplitude of theta oscillations".

Fifth, the optogenetic stimulation is often associated with optoelectrical artifacts, evoked in metal electrodes by the photoelectrochemical effect.
Their degree depends on the electrode material, proximity of the electrode tip to the optic fiber, and light power. In the experiments described
here, optoelectrical artifacts can be avoided by increasing the distance between the fiber and the recording electrode, close positioning of which
is not essential for theta oscillation monitoring. Optoelectrical artifacts display consistent shape in time and between channels and, therefore,
during spike sorting they are typically grouped in a distinct cluster, and do not overlap with recorded neurons’’. At the same time, a small fraction
of action potentials, waveforms of which are altered by artifacts, are not grouped by sorting algorithms with other spikes fired by a neuron.
Laminar LFP profiles obtained using various electrode configurations, including wire arrays (Figure 2B) and linear silicone probes, enable a clear
differentiation of artifacts and true LFP patterns, based on the constant phase of the former and physiological laminar phase offsets of the latter.
Baseline recordings prior to stimulation enable exploration of characteristic theta features such as typical laminar phase profiles.

Optogenetic control of theta oscillations leads to theta entrainment in all layers of the hippocampal CA1 layer and even to contralateral
entrainment. This should be taken to account if an experiment is aimed at a local stimulation (if the effects of a stimulation of a confined
subregion or a subpopulation are aimed to be studied). On the other hand, the spatially limited stimulation of hippocampal projections of MS PV*
cells presented here enables a less deterministic manieulation of theta oscillations, i.e., entrainment, than does somatic optogenetic stimulation
of MS PV" cells recently applied in anaesthetized mice ', The latter somatic stimulation consistently results in frequencies of hippocampal
oscillation up to 40 Hz and thus represents the case of a highly reliable rhythmic pacing. In contrast, the axonal stimulation presented here is
effective ;;referentially in the theta frequency band (Figure 3C), and therefore is more similar to the entrainment, possibly via the Kuramoto

transition 2, i.e., working at frequencies close to the ones present at the stimulation onset spontaneous theta oscillations.

While the optogenetic preparation described here enables manipulation of theta oscillation features, somatic optogenetic inhibition of MS
inhibitory neurons have been applied for efficient inhibition of theta oscillations during REM sleep73. Integration of the two techniques using

Copyright © 2018 Journal of Visualized Experiments June 2018 | 136 | e57349 | Page 10 of 13


https://www.jove.com
https://www.jove.com
https://www.jove.com
/files/ftp_upload/57349/57349fig7v2large.jpg

L]
lee Journal of Visualized Experiments www.jove.com

optogenetic actuators for opposing control of neuronal excitability (e.g., 12) can potentially enable bidirectional control of the theta rhythm in the
same animal for further studies of causal connections between network oscillations and various aspects of behavior.
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